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Introduction

The AVANT ARC (Audiometer and Real Ear Measurement Combination) represents a new era of
ultra-compact diagnostic audiometry and precision in-situ verification for your office. Compact
yet rugged, this PC-Based system is USB powered and supports current ANSI and IEC
audiometric and Real Ear tests. The software includes targets for DSL v5.0 and NAL-NL2. A
unique feature of the Real Ear Measurement System is simultaneous, binaural Live Speech
Mapping, MedRx’s in-situ method for getting the fitting right the first time, every time. The
device performs Real Ear Measurements where measurements are performed directly on the
client's ear. These measurements can be done with or without a hearing instrument being in
place. The reason to perform Real Ear Measurements for hearing instrument fittings is that shape
and size of an ear canal significantly influence a hearing instrument's performance. Knowing the
sound intensity outside and inside the ear enables the practitioner to determine the actual
amplification and output that the patient receives through the hearing aid and make the
appropriate adjustments.

This manual assumes that the system hardware, software and drivers are installed and working
properly. Please refer to the MedRx AVANT ARC Installation Manual for assistance. The
Installation Manual is included in the original AVANT ARC packaging in both printed and PDF
formats.

The scope of this manual is to get you “up and running” with the AVANT ARC System. Please
consult the interactive Help System within the software for more detailed information of
features and functionality. To access this tool, press the F1 key at any time, or click the Help
icon or text menu with your mouse. Access these by clicking on the “Help” tab at the top of the
screen, and select “Help Topics”. Select an item from the list in the Index tab and click “Display”.

Also refer to the Help files for test signal characteristics, analysis, equalization methods and the
effects of analyzer settings on accuracy.
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The AVANT ARC Software Overview

The AVANT ARC Software can run stand-alone or through the NOAH" System or the TIMS®
Office System.

Launching the Software
Stand Alone NOAH and TIMS

1. Launch NOAH.

2. Select Client.

3. In NOAH 4:

e C(lick AVANT AUDIOMETER or
AVANT REM icon on the toolbar.

1. Double Click the AVANT AUD or
AVANT REM shortcut on your
Windows Desktop.

% AMANT SR
& “AUDIOMETER o AVANT REM

Basic Audiometer Software Options

Several option screens are available which allow the user to customize the AVANT ARC
Audiometer Software to meet their needs.

Access these Options from the File Menu The Options may also be accessed from the
on the AVANT ARC'’s Audiometer Main Screen Audiometry screen by clicking Options on
as shown below. the menu as shown below.

Avant Audiometer - Avant AE Avant Audiometer - Avant ARC - Audiometry [ﬁ.ud@

Function Help File Function Ear Output Audio Stimulus Options..

Print Setup... [ r

Page Setup... Audiometry SRT WR Stenger

Clear Session Data

] Advanced Options...
Exit
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The screen shots below detail the Basic Options available.

("options [ fopo [
View | Audiometry | MHAHLS | Tymp | View | Audiometny | MHA/HLS | Tymp |
f:’:::”‘“" m;:f::w = Defaut Level (dB): [65 |
IS Sy Move Down by dB): [10 == Defauft Output IAC-1 -
Language: [V Ao Sound Default Tone: ICurmnuuus -
Im I Reverse Keyboard Arows Speech Scoring ISlandard -
FortSae: [12 ] I Foverse Lovel Conpois Dotk Speech input: [fie -
¥ Dual Plot Mode Defaukt Ear m w ¥ Auto Advance Words, Limt: |25+
L FemacEas Pot Curvee Wit [Mech ¥ Enable Operator Headset
[¥ Maintain Piot Ratios [¥ Use Plot Antialiasing ¥ Enable Talkback Microphone
[0k | Cwed | reb | 0K | Cancel | Hep |
The View tab allows you to set the The Audiometry tab sets the look and
default appearance of the test screen. behavior of the AVANT ARC Audiometer.

Basic REM (Real Ear Measurement) Software Options

Several option screens are available which allow the user to customize the AVANT ARC REM
Software to meet their needs.

Access these Options from the File Menu on The Options may also be accessed from within
the AVANT ARC’s REM Main Screen as shown the Avant REM audio screen by clicking on the
below. Options text menu as shown below.

Avant REM - Avant A_

Function Help

Clear Session Data F\r&nt REM - Avant Al
File

Print Setup... Function Ear Awudic Stimulus  Options.. Tools
Page Setup... | HL . .
‘ Audio | REUR || REUG | m@ %ﬁi’)

Copios |

Advanced Options...

Exit

The screen shots below detail the Basic Options available.

v . == oper: . ==
View | Audio | Live Speech | REM | MHAHLS | Tymp | View | Audio | Live Speech | ReM | MHAMLS | Tymp |
Pt ————————————— Speech Spectum Live Speech Defauk Stmuus: [Microphone |
v Vetical Gri v Cance ¥ Show
I3 :unmrlvtgl ;nd :;z: eech Sounds E :M ;i:‘::; Default Level: (65 _,::'
St Language Fort Size: Smooth O/E: |7 -
<Default> hd - Analyzer T,
Syle: [Lnes -] <Defaut: [z Oa::eﬂands:m Lﬁwuwm‘m
Size: |30 W Interpolate Curves r
Default Ear- |Right v Threshold @B): |45 =
[V Hide Plots During Test Plot Curves Width: W s’:::.r,% . R“"'gm'dﬂ;f: ﬁf' _I
Dusl Plot: [Where Possble _+| R G R Save wih LSM:
Dlsses ive Painting Mode: Ll Skow AvermoslUcE Sposhars
[¥ Maintain Plot Ratios l—_lh"“" ;ms - = <Not Available> -
Microphone: | Both, Simultaneous v
ok | camcel | v | oK | Canced |  Hp |
The View tab allows you to set the default The Live Speech tab sets the look and
appearance of the REM test environment. behavior of the Live Speech Mapping function.
Defaults can be changed by using the check Use the Show Targets pull-down to change to
boxes and pull-down menus shown above. DSL 5.0 or NAL- NL2 targets.
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View | Audio | Live Speech | REM | MHA/HLS | Tymp |

Show Targets

[ Show KEMARat [70 «| dB

Speak
I~ Show SPL Reference Curve pecter

Default Stimulus: A Femdng |5 &
[BBN - Spe=ch Bym= Jid

Smooth Plots: [3° —
Default Leve!: (85 _,;'

e Sample Averaging Time (sec): |0 _ljj
Octave Bands: [1/3  ~
¥ Intempolate Curves ICRA Averaging Time (ssc): |15 _l;l

<Not Available: -
Show REURon [None =
=< Micraphone: [Both, Smutaneous ~

HLS

View | Audio | Live Speech | REM | MHAHLS | Tymp |

Use Live Speech Mapping: ¥ in SPL [~ in HL

Output: [Speakers - Line Out ~|

Defautt HLS Level: &1 _I;l
HLS Simulation: |Nomal 'I

~MHA

Use Live Speech Mapping ¥

Output . [Cliert Headset -

Default MHA Level: (50 _I::
MHA Simulation: | Nommal 'I

oK | Canedl |

Hee |

The REM tab sets the default look and behavior
of conventional Real Ear Measurements.

0K | Cacel | Hep |

The MHA/HLS tab sets the default look and
behavior of the Master Hearing Aid and

Hearing Loss Simulator.

NOTE: Remember, that more information is always available in the Interactive Help System by
clicking the Help Icon or pressing the F1 key.

Advanced Options

The Advanced Options screen allows

you to configure your system to meet your Cle:;ecz::n D'::alp
individual clinical needs. It also provides Brint Setup..
MedRx Technical Support with tools for Page Setup...
helping you troubleshoot technical issues. Options...

Access this screen from the File Menu on
the AVANT ARC’s REM or Audiometer Main Exit

Screen as shown to the right.

Avant REM - Avant ARCj

Avant Audiometer - Avant
Function Help

Print Setup...

Page Setup...

Clear Session Data

Options...

I Advanced Options...

> |

The key features of each tab are described below. For more in-depth information, consult the
interactive Help system within the software by pressing the F1 key or clicking the Help icon.

General | Audio - A | Audio - B | Video | Tympanometry | | General | Auio <A | Audo - B | Video | Tympanomety |

[~ Boost Priority During Measurements COROMDive: [D: = Output Device: x|
I™ Muliple Moritors Input Dewvice: [Lne (2- USB Audio Device) - REN={A) -

¥ Do Not Disconnect from NOAH when Fitting
Output Maxer- [2- USB Audio Device ~|
Home Directory Language input Mecer: 2 USB Audio Device =
input Line: [ <Defaut Line> =]

Device Manager
Cortrol Panel 1
System Information T | L |
oK Carcel | heb | [k | coced | Hb |

General | Audio-A | Audio B | video | Tympanometry | I

Output Device =
nput Device:  [Line (USB Audio Device) - REM+(B) =l
Output Mxer: [ USB Audio Device =]

Input Mocer: [UISB Audio Device |
Input Line: [ <Default Line> =l
‘ Set Defauts | ‘ Audio Propeties |

OK | cancel | Hep |

The General Tab configures
the overall Avant ARC
behavior with respect to other
Windows programs,
specifically NOAH.

Use the Audio-A Tab to select
the proper audio device for
your Avant ARC. This tab also
provides access to the
Windows Audio controls.

Use the Audio-B Tab to select
the proper audio device for
your AVANT ARC. This tab also
provides access to the
Windows Audio controls.

NOTE: The device settings may vary with different computers. Consult technical support before

changing.
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General | Audio - A | Audio - B | Video | Tympanometry | ' General | Audio -A | Audio-B | Videa | Tympanomety | I
- Gtoscope Input
Device: |[ENNELE hd
Tympanometer: | =

Source | Format | st |

r~ Altemative Input

Device: |Not Available LI
OK | Cancd | Heo | [0k | Cancel Help
If your system has a Tympanometer If your system has a Video Otoscope, the
connected, use the Tympanometry tab to Video Tab allows you to select the appropriate
configure the equipment according to the input device.

manufacturer’s instructions.

ARC Accessories

Use the accessories provided with your Avant ARC. Typical acceptable transducers are shown
on the “Connecting the Peripherals” page in the training manual. Operator headsets for use
with the Avant ARC should have 32 ohms impedance and the speaker power should be at least
50 watts. Air conduction transducers for use with this device should have an impedance of 10
ohms. The speaker voltage should match the local outlet power where the device is used.

The Operator Headset with microphone is used by the operator to communicate with the
patient. The patient talks to the operator using the Talk-Back microphone. O

Placing the Earphones on the Patient

The AVANT ARC Audiometer standard configuration includes IP30 Insert Earphones. 3A Insert
Earphones, DD45 or TDH 39 earphones are also available by request. The figures below illustrate
how to properly place these earphones on the patient.

Insert Earphones

IMPORTANT: The foam tips used for the insert earphones are for SINGLE PATIENT USE ONLY.
Do not attempt to wash and re-use them.

1. Place a new set of foam tips on the earphone tubes as
shown. These tips are designed for single patient use and
should not be washed and reused.

e NOTE: When removing foam tips after use, be sure the
clear plastic tubing nipple remains attached to the long
earphone tube.

8 D-0117971-C 05/2019



DDA45 or TDH 39 Earphones

D-0117971-C 05/2019

2. Carefully compress the tip
between your fingers to allow it
to fit into the patient’s ear canal
as shown. Do not roll the tip
between your fingers.

3. Pull up and back on the patient’s
pinna to straighten the ear canal.

4. Place the compressed foam tip
deep within the ear canal.

5. When properly placed, the outer
surface of the insert tip will be
flush with the opening of the ear
canal as shown.

1. Place the earphones on the
patient’s head so the center of
the earphone
is directly over the opening of
the ear canal.

2. Adjust the headband so the
earphones remain in place, but
be careful not to make it so tight
as to cause patient discomfort.

r
Locate the mastoid process behind the pinna.
This is a bony prominence just behind where the
ear meets the head.

Carefully place the bone conductor on the
mastoid process and hold it in place.

Place the headband over the head to the
opposite temple.

Carefully and slowly loosen your grip to check if
the bone vibrator and headband will stay in
place.

If either moves, reposition until both the
headband and bone vibrator are secure.



Performing Audiometric Testing

From the AVANT ARC main screen, click on the “Audiometry” tab to access the audiometry
function. The screen shot below shows the controls which are available from the AVANT ARC
Audiometer main window. The sections of the manual that follow explain how to use these tools
to perform hearing evaluations using your AVANT ARC Audiometer.

Fe foacn for Oupd Aude Siww Optioss Tosh Hep
PUP R Segn || CudSH @ 2. &

. .

00N 554 KL

N -0] x|

Test Selection Tool Bar
Journal or Notepad

Monitor Headset Control

Ear Selection

Output selectors

Test Type Selectors

Tone Type Selectors

Output Level Potentiometers
Masking Interrupter and Routing Selector
10 No Response Button

11. Patient Response Indicator

CoNO~WN=

To exit the program, click on the “Back” button then click “Exit”.

10

12.
13.
14.
15.
16.
17.

Test Interrupter

Back to the Main Screen

Help

Discard Current Measurement
Talk Over

Legend
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Pure Tone Audiometry

Pure Tone Audiometry measures the patient’s peripheral hearing sensitivity, or the softest levels
they can hear pure tones at a variety of frequencies. These thresholds are plotted on a standard
graph called an audiogram. The AVANT ARC software controls the hardware, stores the data

(if running within NOAH or TIMS) and prints a standard audiogram report. Pure tone Audiometry
can be performed via earphones, free field speakers (Air Conduction) or a Bone Conductor (Bone
Conduction). Warble settings are adjustable by the Operator. The Sound Field must be
calibrated on-site, using 4 ohm speakers connected to the Free Field connectors.

Pretesting Procedures/Recommendations:

e Before performing audiometry, careful inspection of the ear canal should be performed.
This is best done with Video Otoscopy. After ensuring the ear canal is clear, place the
appropriate transducer on the patient as shown on pages 8 & 9.

Pure Tone Audiometry via Earphones (IP30 Inserts, 3A Inserts, DD45 or TDH 39)

1. From the Main Screen, click the | * o B button on the right side menu bar.

Audiometry
2. By default, the i button will be selected once you enter the main Audiometry
Screen.
Other default settings (based on typical clinical practice and procedures) are:

Right Ear

AC (Air Conduction)
Tone Stimulus
Continuous Tone

3. Instruct the patient that they will hear several very quiet (soft) tones (beeps) and that
they should signal (raise their hand, press the patient response button, etc.) as soon as
they hear it. It is helpful to also say “even if it seems very far away”.

4. Begin at 1000 Hz in the Right ear (unless the patient reports better hearing in the left ear).

Present a tone at 60 dB by pressing and holding the space bar or clicking and holding the

(- ] Test
5 button.

6. If the patient does not hear the tone (does not signal), raise the level 5 dB using the up

£

arrow on your keyboard or by clicking the button and present again.
7. Repeat step 6 until the patient signals that they hear the tone.

8. When the patient signals they hear the tone, decrease the level by 10 dB using the down

arrow on your keyboard or by clicking the V| button and present the tone again.

9. Repeat steps 6 through 8 until the patient responds to a tone at the same level 2 times
with the level ascending and establishing a threshold.

D-0117971-C 05/2019 11



10. Using the right arrow key, change the test frequency to 2000 Hz and repeat steps 5
through 9 to establish the threshold at 2000 Hz. The threshold at the previous frequency
is recorded when the test frequency is changed.

e NOTE: If the threshold at 2000 Hz is more than 20 dB different (less than or greater
than) the threshold at 1000 Hz, repeat steps 5 through 9 at 1500 Hz (the “half
octave” between 1000 Hz and 2000 Hz).

11. Repeat steps 5 through 9 for 4000 Hz, 8000 Hz, 500 Hz and 250 Hz. Testing half octaves as
needed.

12. Repeat steps 4 through 11 in the opposite ear.

NOTE: The software automatically calculates the 3-frequency Pure Tone Average (PTA) which is
displayed above and inside the legend as follows:

PTA Right: 60dB
| — 7 Conduction, Al=0%, PTASED |

Pure Tone Audiometry via the Bone Conductor

1. Following the instructions on page 11, place the Bone Conductor on the mastoid process
behind the ear with better air conduction thresholds as measured above. If the
thresholds are equal, place the Bone Conductor on the mastoid process behind the right
ear.

2. Establish pure tone bone conduction thresholds as described above for 1000 Hz, 2000 Hz,
4000 Hz, 500 Hz and 250 Hz.

3. Ifthe Bone Conduction (BC) threshold at a given frequency is less (better) than the Air
Conduction (AC) threshold by 15 dB or more, you must confirm the threshold by
performing masking. Masking is always recommended for frequencies above 2000 Hz to
achieve valid results.

4. Repeat steps 1-3 for opposite ear.

12 D-0117971-C 05/2019



Masking for Pure Tone Audiometry

There are several accepted methods for masking. This manual will not promote one over
another, however, to use the masking function on the AVANT Audiometer — Avant ARC, follow
the steps below.

@ Masking B 1. Click the Masking button. The red light will
L appear indicating that the masking is on.
Test Mazk
50de || 80de

= 2. Use your mouse to adjust the Masking Level
2 slider shown on the left to the appropriate level
' based on your preferred method of masking.

! 3. If you wish to maintain the balance of signal and
masking (for example, masking always 15 dB
above the signal), click the Lock button after
setting the masking and signal levels.

R

B @ Lo

WF 4. The default for pure tone audiometry is to deliver
narrow band masking to the ear opposite the
test ear. If you wish to use a different stimulus, or

_‘ I route the masking to the same or both ears, click
»MJ on the arrowXto the right of the Masking On
;  Same Ear button.
Both Ears
I za”m: S\f”_dh"t‘”:i _ 5. Use your mouse to select the new masking type
et and routing for your specific application.
Close

6. When you are finished making changes to the
Masking, click Close.

D-0117971-C 05/2019 13



Speech Audiometry

Speech audiometry evaluates how well the patient can hear and understand speech. The typical
test battery includes tests of speech thresholds and tests of speech discrimination.

The sections below detail how to perform these tests on the AVANT ARC Audiometer.

Speech Reception Threshold (SRT)

The Speech Reception Threshold (SRT) is defined as the lowest dB level at which the patient can
repeat Spondee words with at least 50% accuracy. Spondee words are two syllable words with
equal vocal emphasis on each syllable such as “baseball” or “hotdog”.

Instruct the patient that they will hear a series of two-syllable words that will get quieter as the
test progresses. They are to repeat the words as best they can, even if they sound very far away.
If they are not sure of a word, they should take a guess.

SRT is typically within +/- 5 dB of the patient’s PTA which is displayed on the lower left corner of
the screen. Set the level of the test signal to “a level of familiarization”, done typically 20 dB
above the PTA.

1. From the AVANT Audiometer main
screen, click the Audiometry button.

2. Click the SRT button located on the

SRT

N toolbar on the top of the screen.

$ | $ 3. Select the appropriate test ear icon.

Left Ear Right Eat ‘

‘ wiord List 4. Click the Word List button.
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Speech Audiometry

“wiord List:
y——

w22 List 1 Form &

ML-E List 1 Form &
MU-E List 2 Form &
MU-E List 3 Form &

Spondee Ward List 448
Children’s Spondse Word List

FEE-A0 List 1 Form &
PEEAGD List 2 Form &
PBE-A0 List 3 Farm A

| Start Teﬁ Cancel

Help

X

#  Scone
Total:
Comect:

Incomect:

5. Select Spondee Word Lists A&B from
the list.

6. Click Start Test.

7. Click the Play button or press the F9 key
to present a word. The word will play
through the chosen transducer as well as
display on the screen.

8. If the patient correctly repeats the word,
click the Correcticon or press F7.

9. Ifthe patient incorrectly repeats the word,
click the Incorrecticon or press F8.

NOTE: that the score is calculated and displayed automatically in the bottom right corner of

the screen.

If the patient exceeds a 50% score at a given presentation level, stop the test and decrease

the level by 10 dB and repeat the steps above.

If the patient fails to achieve a 50% score after 6 words at a given level, stop the test, raise the
level 5 dB and repeat the steps above.

When the patient scores 50% at a given level, the test is complete. The software

automatically plots the score on the SRT graph.

Repeat test on opposite ear.

D-0117971-C 05/2019
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Speech MCL & Speech UCL

The patient’s most Comfortable Level and Uncomfortable Level for speech can be obtained
while you are in Work Recognition (WR).

1. From the Avant main screen,
Click the Audiometry button.

2. Click the WR button located on
the toolbar on the top of the screen.

WR

3. Click UCL or MCL.

‘ ALID LcL MCL ‘

4. Choose an input option.

L Mc || Fe | @ |

5. If you selected File or CD, select the

Caibraton Tone track you would like to play for the

Spondee Word Lists . .

W-22 List 1 Form A test in the media player at the

W-22 List 3 Form A bottom of the screen.

MNU-6 List 1 Form A

NU-6 List 2 Form A

NU-6 List 3 Form A | .

e ke 50 When you have selected your track in the
ey e — media player, click play on media player or

WIPI List 2 & 4

Paired C rison Sentences
Calibration Tone it

hit the spacebar to start.

Time: |00:00 > 1] | . .

§e 77 T T ) Adjust levels up or down with keyboard
arrows or by clicking below the dB level at
the bottom of the graph.

Calibration Tone =l 6. ToInput & Calibrate the Rainbow Passage
Time: | 00:00 - || | | in WR fOf MCL:
& & M « » W )
a. Press small Green file folder in bottom
B Open left of media player.
Lock in: | AudioTracks - = .
& e El=s b. Select Rainbow Passage by double
AUDNTEC 6/15/2 i i i
Quickaccsss  cga i clicking twice.
ISTS 7/2/20
D-k'ﬁ CuickSIN 6/14/2
-es P Rainbow Passage 7/2/20
m Sound Sensations 6/14/2
Libraries
La
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—|07-¥oung Male

01-Male

02-Female

03-Male (raised vocal effort)
04-Female (raised vocal effort)
05-Young Female

06-Young Female (raised vocal effort)

08-Young Male (raised vocal effort)
Ug—C librat Pink

Time: | 00:00 2 1] [ |
=] M « » »
10-Calibration {1000Hz) ~|
Time: | 00:10 » 1] |
=1K=] M« » W

=* Left Channel
Right Channel

Close

Start Signal
——
,j\l’ rF

D-0117971-C 05/2019

c. Usethe drop down in the media player
and select track 10 - Calibration
(1000Hz).

d. Click play or start signal.

e. On the VU meter at the top of the
screen, press the slider calibration icon
just below and to the left of the VU
meter.

f.  Adjust with mouse or arrow keys so that
the blue bar stops over the black arrow
and thereis no red.

g. Click on the channelicon just below
and to the right of the VU to switch
channels.

h. Repeat steps d - f for the remaining
channel.

Note: This calibration also needs to be
done with any custom word list.

When using the Mic or live voice option
make sure you press the Start Signal or
space bar to begin.

When using the Mic option adjust your
input using the slider so that it is peaking at
the black triangle under the VU meter.

The VU meter is at the top of the MedRx

Software and will become active once you
press Start Signal.

17



Word Recognition (WR)

Speech Discrimination or Word Recognition (WR) is a discrimination type test using speech as
the stimulus. WR testing measures the percentage of mono-syllable words repeated correctly
from a list. Unlike the SRT test, the WR test is performed at a fixed intensity (dB) level. WR is

typically performed at a patient’s speech MCL. If MCL is not performed, system default options

include, PTA, PTA+20, PTA+30 and PTA+40.

Before beginning the test, instruct the patient that they will hear a series of one-syllable
words. They are to repeat the words as best they can. If they are not sure of a word, they should

take a guess.

“Wh

$ [

Right Bath

| Yo List

Speech Audiometry El

wlond List:

Spondee Word List ALB
ildrer's Spondes Wword List

Childr

0 List 2 Form A

t

t

t 3 Form &
PBE-50 List 1 Farm &

Li

List 3 Form A

Start Test Cancel Help
I

# Score: | 92%
Total: | 25

N ota
Corect: 23

- Start Signal Incanect: 2

From the AVANT Audiometer main screen, click
the Audiometry button.

Click the WR button located on the toolbar on
the top of the screen.

Select the appropriate test earicon.

Click the Word List button.

Select the desired Word List from the list. The W-
22 or NU-6 lists are good choices for most adult
patients. When testing children, the PBK lists
should be used.

Click Start Test.

Click the Play button or press the F9 key to
present a word. The word will play through the
chosen transducer as well as display on the
screen.

If the patient correctly repeats the word, click
the Correcticon or press F7.

If the patient incorrectly repeats the word, click
the Incorrect icon or press F8.

. The next word will automatically play when the

previously presented word is scored.

Note that the score is calculated and displayed automatically. The test is complete when all words in the
list have been presented. The software automatically plots the score on the WR graph.

Repeat test on opposite ear.

18
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QuickSIN (Optional)

The primary complaint of hearing-impaired persons is difficulty hearing in background noise.
The measurement of SNR loss (signal-to-noise ratio loss) is important because speech
understanding in noise cannot be reliably predicted from the pure tone audiogram (Killion &
Niquette, 2000).

The QuickSIN test was developed to:

Provide a one-minute estimate of SNR loss.
Provide a quick way for clinicians to quantify a patient’s ability to hear in noise.

3. Determine if extended high frequency emphasis improves or degrades understanding of
speech in noise.

4. Assist professionals in choosing appropriate amplification and other assistive
technologies.

5. Demonstrate that hearing aids with directional microphones improve speech
intelligibility in noise.

6. Provide a large number of equivalent test lists for use in clinical and research work.

7. Provide information useful in counseling patients regarding realistic expectations.

The screenshot below shows the key features of the QuickSIN

test.

1. Calibration Button 4, List Selector

2. EarSelector 5. Track Display

3. Output Selector 6. Track Control

7. Test Type Selector
I I et i e ~— el
atomalty SAT wh Sherger DuackSIN 2 W - W @
List1 Al . -
rmr.ks . . . — SN Score - @ ﬁ f’ ’g'
e e ; —
© 3 Foolprinis showed the path he took up the beach SIN 15 g @ EARTuw s
v 4. A vent near the edge brought in fresh air @ S/N 10 &
# 5. Itis a band of steel three inches wide SIN 05 K "
v 6. The weight of the package was seen in the high scale SIN 00
- = i

255-TOTAL= 255 SNR loss @
Select a sentence... Score

Mo PTA available Please perfarm Tone Audimetry test
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Performing the QuickSIN Test

o From the Avant main

T . Click the QuickSIN

imulus

screen, click the

Options...

Tools  Help

button on the top of

Audiometry icon. ]

Stanger

‘ QuickSIN the Audiometry

screen.

Present the test with earphones or in a sound field. The attenuator dial is set to 70 dB HL. For subjects with
PTA hearing losses greater than 45 dB HL, the attenuator dial is set to a level that is “loud but OK.”, this is
done by the program using the MCL value. A warning legend at the bottom of the window is shown if PTA i
not available. Instruct the patient to repeat the sentences spoken by the target (female) talker. When testinc
in a sound field, have the patient hold the talkback microphone close enough so that responses are clearly

audible to the tester.

List1
List 2
List 3
List 4
List5
Listb
List 7
List 8
List9
List 10
List 11
List12

| Select |

| QuickSIN HFE

List 1

Tracks S/N Score
1Y 1. A white silk jacket goes with any shoes S/IN 25
2! 2_ The child crawled into the dense grass S/N 20
<) 3. Footprints showed the path he took up the beach S/N 15
<) 4_ A vent near the edge brought in fresh air S/N 10
2! 5_Itis a band of steel three inches wide S/N 05
< 6. The weight of the package was seen in the high scale S/N 00
= Play >
List 1
Tracks SIN Score lﬂ
=}y 2. The child crawled into the dense grass SIN 20 4
1y 3. Footprints showed the path he took up the beach SIN 15 3
1y 4. A vent near the edge brought in fresh air SIN 10 3
1y 5. ltis a band of steel three inches wide SINO5 2
$M16. The weight of the package was seen in the high scale SIN 00 1 -
<< | Pay [[>]
25.5 - TOTAL= 7.5 SNR loss (Average SNR loss = 7.50)
Moderate SNR loss. Directional Microphones help. Consider array mic.
The weight of the package was seen in the high scale Score
r % r rr °
Left | [ Right |

List1: Unaiced: AC: Lewel=70dB; SNR loss=7.50 dB

20

1.

3.

Select a list from the List
Selection Window one of
the following two ways:

e C(lick the list, then click Select.

e Or Double-Click the list number.

Play the first sentence in the
list by clicking the Play
button.

Ask the patient to repeat
the sentence.

Score the patient’s response
one of the following ways:

e Click the check-box of each
correct key word with your
mouse. This will record the
total number of correct key
words in the score pull-down.

e Record the total number of
correct key words using the
score pull-down or by pushing
1-5 key on the keyboard.

4. Click the next sentence and then

click Play or click >>. This will
advance & play.
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5. Repeat steps 2-4 until all 6
sentences in the list have been
played and scored.

List 1

Tracks SiN Score |-l .

B 2 17 S T e o s s w4 After all six sentences are

<y 3. Footprints showed the path he took up the beach SIN1S 3 -

N e e o ey sm - scored, the following

<4 5. Itis a band of steel three inches wide SIN 05 1 = -

6. he weight ofte pck:ge was seen in the high scale SINOO 0 resu’ts are d’splayed-

R
25.5 - TOTAL= 10.5 SI.\IR Ic.Jss (Av.erage SNR loss = 10.50,) . ° TOta| SN R LOSS |n d B‘
Moderate SNR loss. Directional Microphones help. Consider array mic. .
o Recommendations.
The weight of the package was seen in the high scale Score
m ] ] E = o -

Additional information on interpreting the QuickSIN is available in the Interactive Help
system. Top access this, click the Help icon or press the F1 key.

Tinnometer (Optional)

Purpose of the Tinnometer

Tinnitus is experienced by millions of people worldwide. The Tinnometer is designed to mimic
the sounds of tinnitus in order to provide an accurate and flexible tinnitus assessment. Tinnitus
Assessment increases patient rapport with the clinician when an equivalent tinnitus sound can
be created. The Tinnometer can accurately create tinnitus sounds for fast and reliable tinnitus
assessment. All test results should be used to help counsel the patient on their specific tinnitus
and what the assessment has found.

The Tinnometer test was developed to:

Break away from the traditional limitation of tinnitus assessment with an audiometer
Produce accurate and flexible sounds that mimic patient tinnitus

Provide extended frequency ranges to more accurately match tinnitus sounds
Decrease the time needed to complete a tinnitus assessment

Standardize reporting needed when completing tinnitus assessment

Allow clinicians to save and recall prior tinnitus assessments

Provide general guidelines for implementing results into tinnitus sound therapies
provided by leading hearing aid manufacturers

No vk wn =
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Performing the Tinnometer Testing:

e Click the Tinnometer button from
@ the main Avant Audiometer main
screen.
Tinnometer

The following screenshot shows the key features of the Tinnometer:

1. Toggle Switch to Start/Stop stimulus 4. Buttons used in determining tinnitus
2. Sliders to control frequency, match, threshold and minimum

bandwidth, slope and tempo of the masking level

stimulus 5. Area where description of items will
3. Slider to control the intensity of the be displayed

stimulus 6. Channels designed to present

multiple types of tinnitus sounds

7. A graphical display of the sounds being played for the patient. Stimulus and
Audiogram (if done within Avant or Noah) are display in dB SPL

Interactions with the patient are controlled as follows:

1. Patient response switch indicator 4. Undo
2. Patient monitor microphone 5. Toggle help section
3. Talk forward 6. Return to Avant
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There are 3 Steps needed for Tinnitus Assessment with the Tinnometer
Identify patient’s tinnitus by frequency, bandwidth, slope and tempo

Lower the identified tinnitus until patient threshold is reached

Raise the tinnitus level above the identified tinnitus intensity (widen bandwidth if
needed) until the patient states they no longer hear the tinnitus. Play stimulus for 60

1.
2.
3.

seconds to ensure masking is achieved.

Step 1: Identify Patient’s Tinnitus

AedKx - Speakers (MedRx ARC Audio - A] - linnoMete:

Audio Clutput |Tnn|tus Type | Questionaire  Informati

o 0 Ringing
Whistling

Hissing

Buzzing

Humming

Start by selecting the tinnitus type

that has been described by the

patient. This is an approximation of
the tinnitus sound your patient hears.
Tinnitus type will provide a starting
frequency, bandwidth and slope to
help speed up testing time.

Use the stimulus start/stop toggle to
present the selected signal to the
patient.

Frequency I I: ]I I

Z20Hz S0Hz 125Hz 250Hz S00Hz 1k

C—l—3 -

I’_f/J_JL_\-,\‘\_\ "
ICI————— I E.

- Tinnitus
[ evel

E8)

= Level
Threshold

3. Use frequency slider to match the

pitch of the patient’s perceived
tinnitus

Use volume slider to match patient’s
perceived intensity of tinnitus

Adjust bandwidth, slope and tempo
(for pulsating tinnitus or prevention of
adaptation) as needed

D-0117971-C 05/2019

Buttons to allow greater flexibility in
bandwidth and slope of tinnitus.
Allows the addition of high/low
frequency sounds independently
Allows for independent right/left
volume control

Press Tinnitus Level button once the
patient’s tinnitus is matched
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Step 2: Find Identified Tinnitus Threshold

1. Use down arrow on your keyboard to

0 —  Level lower stimulus until patient states
Threshold they are no longer able to hear the
tinnitus.

2. Click Threshold Level button.
Step 3: Masking Tinnitus for 60 Seconds

v g 1. Use volume slider to increase

intensity of the stimulus until the
patient states they are no longer able
to hear their tinnitus.

120

100
80

60 Tinnitus
-

=

m

111

40

NOTE: Lower levels of masking may be
7 achieved by increasing bandwidth of
'W'ﬂ' the masking stimulus. Pulsating the
masking noise can prevent tinnitus
adaptation.

20

0

L 2. Press the MML button and continue
o presenting stimulus until 60 second
i countdown ends.

3. If patient begins to hear their tinnitus
within the 60 seconds, raise intensity
until masking is achieved and repeat
number 2.

Tinnometer Modulation Tab
The Tinnometer modulation tab is designed to simulate sound generators when

hearing aid demonstrations cannot be performed. The following are controls
used in Modulation.

["]Random E
[ Music 20 I‘ i
["1Ocean modulatic D

-20

-0

50

- I [ B | ®

Level modulation

1. Type of modulation Sound 3. Frequency of modulation
2. Speed of modulation 4. Modulation volume range
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To use the Modulation features within Tinnometer, you must first complete the
three steps involved with tinnitus assessment. Once tinnitus assessment is
complete, you can use modulation by:

= _ 1. Activating the channel in
CNanne which the tinnitus
assessment was
- . = performed.
06dB 4842.29 Hz 66dB
S6dB Threshold Level S6dB
45L Relative Tinnitus Level 451
105L Relative MML 105L
Low High
Band 0.15 0.15
in octave
slope 100 100
in %

2. Enter the modulation tab
on the right side of
Tinnometer software.

["]Random
[ Music 20 I‘ '
[]Ocean modulatic (]

-20

-40

-0

-0
i 1

. -~ T

Level modulation

3. Adjust the modulation stimulus with sliders as a counseling tool for the
patient.
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Tinnometer Audiometry Scan

The Tinnometer Scan tab is designed for various forms of air conduction
audiometry. There are three types of audiometry that can be performed with
Tinnometer. You can access the forms of audiometry with the buttons located

by the number 1 in the image below.

BEKEZY

@ =

Audiogram

Tinnometer Residual Inhibition (RI)

The Tinnometer RI tab is designed for Residual Inhibition (RI) testing for a
patient’s tinnitus. The controls in the RI tab are as follows:

R R R R T W W W WY 1. Scale from 0-10 of

- tinnitus bothersome

level

memmmmmmmmzm oo oo oo oo .- ® 2. Timer to begin

: stimulus

- 3. Tracking of patient’s
/1\ ’2\ tinnitus bothersome
U level as a function of

n@r S time

. sy ——
0000000000 (1%

?53‘025\

A complete tinnitus assessment must be performed prior to performing testing
in the RI tab. Once tinnitus assessment testing is completed, optional residual
inhibition testing can be performed with the following steps:
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Cicaculy O

56dB Threshold Level 56dB

451 Relative Tinnitus Level 451

10SL Relative MML 10SL
Low High

Band 0.15 0.15

in octave

slope 100 100

in %

ad

.
OXOJO),

1. Activating the channel in
which the tinnitus
assessment was performed.

2. Select the RI tab on the
right side of the Tinnometer
software.

3. Ask the patient the
bothersome level of their
tinnitus from 1 to 10 and
mark their response.

4. Click the stop watch to
begin the masking stimulus
(stimulus to play for 60
seconds).

You will hear a masking noise for 1 minute

Then the noise will suddenly stop

The patient will have to redefine his discomfort about every 30 seconds.

5. Stimulus will play for 60 seconds and automatically stop at the 60 second

point.

D-0117971-C 05/2019
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@
POODOO®

7.

When the stimulus stops the patient must redefine their tinnitus
bothersome level every 30 seconds. The bothersome level should
decrease upon the stimulus stopping and will increase with time.

The test continues until the bothersome level returns to pre-test level.

Tinnometer Report Printing

The Tinnometer has four reports available for printing: tinnitus assessment
report, manufacturer guidance report, questionnaire report and a channel
report.

The following are common features found across reports:

Y MedRx - Speakers

Qutput  Tinnitus type  Questionaire  Information  Lan

Mew

Open
Save
Manufacturer Guidance  »
Print + printer ...

Exit

us

28

1.

To generate your report,
select “printer ...” from
the File menu.

. Select the paper style

you are printing.

. Confirm all patient

information is correct.

. Choose your print

preferences.

. Change the zoom of your

print preview.
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Tinnitus Assessment Report

6. Print your Report.

Tinnitus assessment reports are able to be generated after completing the
three steps to tinnitus assessment. Once all steps are complete you are able to

print a report

O M - Speakers (5 USE GG DEEE) TrroVEier e

Output  Tinnitus type  Questionaire  Information  Lan

Mew
Open o

Save
Manufacturer Guidance 3

Print * printer ...
Exit

Channel 1

Channel 2

All Channels

dance
Graph Channel 1
Graph Channel
Graph Channel
Graph Channel 4

[N

Diagnosis Code

H93.11 Tinnitus, right ear
H93.12 Tinnitus, left ear

H93.13 Tinnitus, bilateral
H93.18 Tinnitus, unspecified ear

Comments 4x60 characters

D-0117971-C 05/2019

1. To generate your tinnitus

assessment report, select
“printer ...” from the File menu.

The “Channel” reports are the
tinnitus assessment reports.
Select the channel used for
testing or All Channels when
multi-channel testing is
completed.

Use the drop down box to
select a diagnosis for the
patient.

Comments can be entered in 4
separate lines with a maximum
of 60 characters.

Print the Report.
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Manufacturer Guidance Report

Manufacturer guidance reports are designed to provide hearing aid sound
therapy guidance to a clinician based on tinnitus assessment results. Sound
therapy is an option to tinnitus treatment. We encourage all clinics to develop
a tinnitus treatment protocol that is in line with their tinnitus treatment goals.
Manufacturer guidance generated by the Tinnometer is designed to be a
starting point in sound therapy and each patient may differ in preferred sound.

Manufacturer guidance reports are able to be generated after completing the
three steps to tinnitus assessment. Once all three tinnitus assessment steps
are complete you are able to print a report.

Medm - Speakers

Output Tinnitus type  Questionaire  Information L 1- SeleCt the manUfaCtU rer that
oo D) you would like to have printed
in your report.

Manufacturer Guidance  » Gticon
Print . Phonak

Exit Sigria

Bernafon
Sonic
Beltone

@ Medh - Speakers (5~ USE Ao Deice]TrnaMeer Me i
Qutput  Tinnitus type  Questionaire  Information  Lan 2' To generate your tlnnltus
New O assessment report, select
Open “printer ...” from the File menu.
Save
Manufacturer Guidance v
Print v printer ...
Exit
Channel T 3. Select “"Hearing Aid Guidance”
anne .
T s from the list of reports.

Hearing Aid Guidance

Graph Channel 2
Graph Channel 3
Graph Channel 4

Diagnosis Code 4. Use the drop down box to
El select a diagnosis for the
H93.11 Tinnitus, right ear

H93.12 Tinnitus. left ear patient.
H93.13 Tinnitus, bilateral
H93.19 Tinnitus, unspecified ear

Comments 4x60 characters 5_ Comments can be entered |n 4
separate lines with a maximum
of 60 characters.
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6. Print the report.

Graph Channel Report

Graph channel reports will print a patient report which displays an image of the
patient’s tinnitus with QR codes for YouTube videos that play a wind
modulation noise nearest to their tinnitus. To generate the report you must:

E;”W 1. To generate your tinnitus
ile utpu innitus type  Questionaire nformation an assessment report, Select

Mew
A\Y H 14 H

open o printer ...” from the File menu.

Save

Manufacturer Guidance »

Print b printer ...

Exit
Chanel 2. Select “"Graph Channel” from
All Channels the list of reports. Select the
o channel humber which you

raph Channel 1 ! ,

Graph Channel 2 used to match your patient’s
Graph Channel 3 ti it d
Graph Channel 4 INNITUS souna.

3. Print the report.

Questionnaire Report

Questionnaire reports will only show as an option once the questionnaire has
been completed. Once a questionnaire has been completed and you are ready
to print a report you must:

‘::xmuprT::ims type Questionaire Information Lan 1' TO generate your tlnnltus
New o assessment report, select
Open “printer ...” from the File menu.

Save
Manufacturer Guidance r

Print 3 printer ...
Exit
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Channel 1 2. Select the name of the

All Ch | i i i
e idance questionnaire you want to print

Graph Ch 11 i
Grah Channsl 2 from the list of reports.

Graph Channel 3

|THI

3. Print the report.

Hearing Loss Simulator

The Hearing Loss Simulator (HLS) demonstrates the effect of the client’s hearing loss for
the significant third party. The program attenuates an input signal to simulate the
audiogram. The third party listens to the free field speakers. The third party can hear how
their own voice is distorted by the hearing loss when the Record input option is used.

The Hearing Loss Simulator requires the client’s Audiogram data. This data can be
manually entered in the Audio screen of this or any other task.

How to perform the Hearing Loss Simulator task

o Select the HLS tab on the toolbar.

e Enter the Audiogram values manually if the data is not automatically imported to this
screen.

o Select the input signal type: Mic, File or Record. Select the track and the Play button on
the control panel. See below for instructions on how to use the Record option.

e The HLS output is directed to the free field loudspeakers.

o Select Normal to play the input signal as a person with normal hearing would perceive
it. Select Simulated to turn on the simulation of the client's hearing loss. Toggle
between these selections as necessary.

e The Reset option restores the audiogram to the original state. Use this option if you
have modified the audiogram but want to undo the changes. The changes to the
Audiogram that are made on the HLS screen are temporary and will not affect the client's
original audiometry record.

e Avolume control adjustment bar allows for manual adjustment of the output level of the
free field speakers.

o To stop the playback, select the Stop button on the player.

NOTE: It is recommended you use a variety of tracks from the list to demonstrate the hearing
loss.

Record Input Option
This option allows recording and playing back of the voice of the third party.
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Master Hearing Aid

Master Hearing Aid (MHA) is an alternative to using a stock hearing aid to demonstrate the
benefits of amplification to an inexperienced user. The system applies the fitting rules by default
to the patient's audiogram and simulates a hearing aid. The patient listens to this signal through
the headphones. Options for editing the gain applied to the audiogram are provided.

About the Master Hearing Aid Display

The Master Hearing Aid screen displays a graph with dB Gain on the vertical axis and Frequency
in Hz on the horizontal axis. The plot on the graph represents the gain applied to the patient’s
Audiogram. The NAL-RP is applied by default. A new rule can be selected from the list on the
right side of the display. A volume adjustment bar allows for manual adjustment of the output
level. The control panel on the right of the display provides options for input signal source and
the task icons for Normal and Simulate.

The Master Hearing Aid applies gain separately for each ear. If audiogram values are entered for
the left and right ear, the selected fitting rules will be applied to each ear separately. Different
rules may be entered for different ears (i.e. NAL-RP for left ear and BERGER for right ear). If an
audiogram is entered only for one ear, the gain will not be adjusted for the opposite ear and the
sound for that ear will be normal.

If Binaural mode is selected, the sound will be heard from both channels (left and right). If
Monaural mode is selected, the sound will be heard only from the channel corresponding to
the active ear when the channel for the opposite ear will be muted.

Input signal

Live voice (microphone) allows you to use the talk-over microphone for live speech input to
the inserts. The clinician or significant third party can speak into the microphone for this activity.
Note: there is a processing delay between the input and playback. Make sure that the client
cannot hear the voice directly but only through the headset. If this is not possible, use the
Recorder (describer below) to simulate speech input.

File allows the user to play sound files. The program supports MP3 and WAV files and comes
with pre-set MedRx Sounds Sensations sound files. After the option is activated, use the player
panel to control the playback.

CD allows the user to play music CDs. After the option is activated, use the player panel to
control the playback.

Record input mode allows the clinician or third party to record a sample of their speech which
can then be replayed for repeat comparisons under different amplification conditions for the
patient. Refer to the interactive Help system by pressing F1 or clicking the Help icon to learn
more about the recorder.
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How to use the Master Hearing Aid:
1. Select the Master Hearing Aid (MHA) icon from the main screen.

2. Enter the Audiogram values manually if the data is not automatically imported to this
screen.

3. Select the input signal type: File, CD, Mic, or Record.
4. Select Monaural or Binaural.

5. Select the Normal icon, which will send the input signal through to the inserts without
modification. The patient is listening to the signal without any amplification benefit.
Select the Simulate icon to modify the input signal according to the selected rule. This
selection allows the patient to hear the benefits of amplification. Toggle between these
two selections as necessary.

6. If the simulated frequency response needs to be adjusted, based on feedback from the
patient, manually edit the response by clicking on the gain curve at the desired
frequency and new gain level. The gain curve of the selected test ear on the control
panel can be edited. To edit the other ear, click the appropriate test ear icon on the
control panel first.

Hint: Use the track returnicon on the player control panel to replay one track continuously.

| =l
Tirme: Z - 1 [ |
] ]

s =] H L g

The Reset option restores the rule to the original state. Use this option if you have modified the
rule but want to undo the changes.

Preparing for Real Ear Measurement Testing

Loudspeaker Output Selection

There are two possible loudspeaker selections. Either the Line Out selection that uses powered
speakers as shown on the following pages or the internal amplified speaker output (Red and
Blue connectors) can be used with passive speakers. Go to the Tools menu and select the
speaker selection you want. A check mark will be shown next to the selection. Refer to the
speaker wire installation method under “To Install Free Field Speaker Wires” seen below.
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BB 2vant R - vt ARCHENGSBBGEN Wapsing
Fle Function Ex Audo Stmubs Options... |Tools Hebp
W, Deete =
Ao REUR | REUG o Delete Al 4 ‘.,,

SPL i) ke K

ResetData

Probe Monitor
1201 Callbrate Probe Tube

Callorate Speakers

10 ¢

Speaker Calibration™

Open the Speaker Calibration screen from REM/LSM screen menu Tools > Calibrate
Speakers.

Eant REM - Avant A
File Function Ear Audic Stimulus Options.. Help

HL @ | [ Delete %
Audio REUR || REUG | | | Speeh 2% Delete (s
HL ({dB) ' Joumnal F4
Reset Data
D Probe Monitor |
< Calibrate Probe Tube
o) Calibrate Speakers |
Loudspeaker Output »

The speaker should be positioned in such a way that nothing blocks the path of the emanated
sound in front and on the sides of the speaker. For example, positioning a speaker behind a
monitor is incorrect and can severely affect its response at the measurement location. The
speaker diaphragm should be at about the same level as the patient's ear and the reference
microphone.

Place the reference microphone at the location where the patient normally sits, or about 1 meter
from the speakers.

Click on Start to begin the calibration and wait until it ends. Observe the response curve flatten
itself out. The darker curve is showing the response used by the equalization algorithm, the
lighter curve is showing the current microphone input. Use of the powered speaker supplied
with this device is recommended.
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Positioning the Speakers

Proper positioning of
the loudspeakers
relative to the patient’s
hearing instruments is
critical for making
accurate and repeatable
measurements. Seat the
patient so their ear is
between 19 and 39
inches from the
loudspeaker.

Make sure the grill of the loudspeaker is level with and directly in front of the patient’s head.

19 n _ 39 n
(48 -100 cm)

When using Live Speech inputs, position the patient so the mouth of the person speaking is in the
same position as the loudspeaker shown here.

v(alibrating the Probe Tube ()

& For reasons of infection control and reliability of results, MedRx recommends that a new probe
tube be used with each patient. To ensure accurate measurements, it is necessary to calibrate
the probe tube each time it is replaced.

1. Place a new probe tube on the
probe microphone port as
shown.

2. Place the probe tube between
the calibration nibs as shown.
Be sure that the opening of the
probe tube is centered on the
opening of the reference
microphone.
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In the Avant REM - Avant ARC software, do one of the following:
e C(lickthe i e C(lick Tools. e — B2 e

Probe Tube ‘f“‘“’ e Click Calibrate ][ [
Calibration or Probe Tube. HL @B} ::::m F
Icon. JT—— T i

Probe Monitor

Calibrate Probe Tube

Calibrate Speakers

Loudspeaker Output

Position probe microphone with
probe tube in calibration position
between 19 and 39 inches from the
loudspeaker and Click Start. The
signal must be at least 70 dB to
complete a valid calibration. If the
screen prompt indicates the signal is
too low, increase the volume on the Microphane: [Right Probe =l
loudspeaker or move the probe

microphone assembly closer and re- e e e entop e e meeehons
start the calibration. The system will - Adust the vcume so hatthe Ref. Level s above 70dB
calibrate and stop on its own.

Reference Level:

Start |

Repeat for the other probe. Valid
calibrations have the same
approximate shape as the gray target
curve. If the measured calibration
curve differs greatly in shape or
amplitude from the gray target curve,
replace the probe tube and re-
calibrate. If this does not correct the
problem, contact MedRx technical
support at (888) 392-1234.

The calibration date is available from the AVANT ARC main screen under the

Function > Calibrate > Calibration Information tabs.

Return Probe Microphones to MedRx for annual re-calibration. Annual re-calibration Votthe
Avant ARC Probe Microphones is recommended. There are no user repairable components of
this device.
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Live Speech Mapping

Step-by-Step Guide to Live Speech Mapping
Ensure the Audiogram is Entered

Before making Live Speech Mapping measurements, the patient’s pure tone audiogram must be
available to the software. This can occur several ways:
1. The audiogram was automatically entered by MedRx AVANT Audiometer software when
testing. Then saving the NOAH session.
2. The audiogram was manually entered into the NOAH software and saved.
3. The audiogram was entered using another manufacturer’s audiogram module and saved
in NOAH.

If none of these have occurred, you may manually enter the audiometric data into the Avant
REM - Avant ARC software as follows:

AVANT

REAL EAR MEASUREMENTS

i
il

ix

-

N

1. Launch the audiometric module by Using your mouse, select the test ear.
clicking on the Audio button on the Select the test type Air.
right side of the AVANT main 4. Enter thresholds by clicking the
window. intersection points with the mouse.
(You may also enter the audiogram by
selecting the audio tab in either the
LSM or HLS/MHA screens).
5. Repeat for UCL (Bone and MCL
optional).
6. Repeat steps 3-5 for the other ear.

w

After the audiogram as entered, click the Back button to return to the AVANT Main screen.

£

LSM

1. From the AVANT Main screen, click LSM.

Le @, 2. Inthe next Window, click LSM again.
Speech
Ilapping

The Operator Headphone is used by the operator to monitor the signal being received by the
probe microphone.
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The screen shot below provides an overview of all the tools and controls on the Live Speech
Mapping screen. For more information on these features, please consult the Interactive Help
system by pressing the F1 key or clicking the Help icon.

m\mnt REM - Avant ARC

File Function Ear Audio Stimulus Options... Tooks Help

oo [s - ——
‘i Moo | i ﬂ @ - C /'i\
( )
~ $- |9
SPL(dB) SPL (dB) LetEar | | Right Ear
120 120 ‘@ fi
LTAS
10 = Il Pects |JJRLIER]

‘ || |
25 250

ﬁ’?lW
u

- Open Fit

T\

o

Frequency (Hz] |

I— i Conduction, Al=31%, PTA=d0
— Uncomtortable lewel
— Fi Conduction, Als23%, PTAR4S
— rcomtortable lewel

®x L&

Help Back.

1. Sound level meter
2. Earselection
3. Measurement type
e Peaks
e LTAS
4. Input Selector

D-0117971-C 05/2019

5. Open Fit Function

6. Reset Button

7. Test Interrupter

8. Discard, Help and Back buttons
9. Legend

10. Target area — can be any of the

following:

e MedRx Modified Speech Spectrum
e DSLIO
e NAL-NL2
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.A w‘ ech Mappm with Live Vo ce Inputs

e e The screenshot on the left shows the Live

» (2 Speech Mapping (LSM) window. The
- system is designed to capture and display
£[E the human voice in the ear canal, so it is
j_* recommend to use the microphone input
= and the peaks measurement.
® @

Using the microphone allows

= measurement of both the professional’s
voice and that of the patient’s significant
other.

lili
ix

i
it

To improve repeatability of measurements,
it is recommended that the speaker read a
standard passage such as the “Rainbow
Passage” which is provided on pg. 31.

&NOTE: The screen shot above shows the MedRx Modified Speech Spectrum (Canoe). It is also
possible to underlay DSL 10 or NAL-NL2 targets on this screen. Click Options in the text menu bar on
the top of the screen to select and configure these underlays to meet the needs of your practice.

Speech Mapping with Recorded Inputs

o - e ~ " Forthose who prefer a recorded,
N - - - s s repeatable stimulus for Speech Mapping,
« - the software provides several digital audio
- * s SRR 2 = files. These are accessed by clicking the
- # ¥ File button on the right and then selecting
- " thedesired track from the pull-down
@ @ menuin the audio player. Peak

measurements is recommended.

- T T x
. Owcad.

frt

Once the desired track is selected, click the
Start button to begin measuring. A pure
tone or white noise will be presented and
once it reaches the selected input level
with the slide bar, the chosen track will
play. When enough data is collected, click
the Stop button to stop the recording and
capture the measurement.

It is also possible to use an audio CD, such as the patient’s favorite music to perform Speech
Mapping. Simply click the CD button and then select a track as above. Use the sound level
meter on screen to check the proper level. Adjust the output of the speaker to desired level
using the sound level meter. (Remember conversational speech is 65 dB SPL at 1 meter).

ANOTE: The screen shot above shows the MedRx Modified Speech Spectrum (Canoe). It is also
possible to underlay DSL 10 or NAL-NL2 targets on this screen. Click Options + Show Targets in the
text menu bar on the top of the screen to select and configure these underlays to meet the needs of your
practice.
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Running Speech Mapping “On-Top” within NOAH

It is well established that verifying the output of hearing instruments in the patient’s ear will
improve the accuracy of the fitting. In the past, it has been difficult to verify these fittings since

many real ear systems have been disconnected from the fitting system. The AVANT ARC system

is tightly integrated with NOAH, the industry standard for audiometric and fitting data storage

and retrieval. The “on-top” mode of the Avant REM - Avant ARC software allows you to
effortlessly alternate between measurement and fitting adjustments.

E Avant REM - A

File Function F

LE

-

From the Avant ARC main screen, click the NOAH LSM button.

The Avant REM - Avant ARC window will reduce in size and float
“on top” of the NOAH screen.

Open the fitting module from the NOAH Module Selection
Screen.

Use the text menus and green (start) and red (stop) buttons in
the floating LSM window to make Speech Mapping
measurements.

Make necessary changes to the instrument based on these
measurements.

To make adjustments to the hearing instrument, click on the
fitting module window and modify the settings according to the
manufacturer’s instructions, being sure to activate, apply or save
the settings to the instrument.

Repeat this measure/adjust/measure cycle until the fitting is
optimized.

Completing the On-Top Mode Process

Close the REM module by clicking the X button and select the Exiticon. Save the NOAH session

when prompted.

D-0117971-C 05/2019
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MedRx Live Speech Mapping Protocol

Unlike other products, the AVANT ARC system places full control over the measurement environment firmly
in the hands of the hearing care professional. The system is powerful, yet extremely flexible, allowing each
provider to use Live Speech Mapping in a way that compliments their practice style rather than

compromising it.

In order to get you “up and running” with the AVANT ARC system, MedRx has developed the following
protocol. This simple procedure has been found to be effective with both audiologists and hearing instrument
specialists. After mastering the basic operation of the system utilized in this protocol, you are encouraged to
further expand your use of Live Speech Mapping in your practice. Feature-specific help is available by simply

pressing the F1 key or clicking on the Help icon or text menu.

1. Complete a careful otoscopic examination as instructed by the
manufacturer of your otoscope.
e For MedRx Video Otoscopes, refer to the Help system within the
software by pressing the F1 key or clicking the Help icon or text
menu.

2. Basic Diagnostics.
a. Using your audiometer and NOAH, measure and record the
following values:
. Pure Tone Air and Bone conduction thresholds.
¢. Narrow Band Noise or Pure Tone UCL at 500, 1000, 2000 and
4000 Hz.
d. Other tests if needed in your practice or jurisdiction.

3. Position patient as described earlier in this manual.

4. Calibrate Probe Tube as described earlier in this manual.
Measure and place the probe tube in the ear canal. (Use guide to the
right).
6. Complete a Live Speech Mapping measurement UNAIDED.
a. Microphoneinput.
b. Peak Measures.
¢. 1/3 Octave resolution.

b

7. Carefully place the hearing instrument in the ear without disturbing the
probe tube.

8. Complete a Live Speech Mapping measurement AIDED.

9. Using the On Top Mode, make any adjustments needed to the hearing
instrument so that:

a. The LSM curve for Quiet Speech (50 dB) is at the bottom of the
white modified speech spectrum (canoe).

b. The LSM curve for Conversational Speech (65 dB) should be
within the white modified speech spectrum.

C. The LSM curve for loud sounds (85 dB) (very loud speech,
clapping hands, etc.) is approximately 10 dB below the UCL
curve.

42

Probe Tube Insertion

Guide
for Live Speech Mapping
and Conventional REM
(re: Pomford, J & Sinclair, S. Real-Ear Measurement:
Basic Terminology and Procedures. Audiology OnLine.com)
X o ]
Male (30mm)
(Adult)
N | ]
Female (28mm)
(Adult)
K | — ]

Child (20-25mm)

1. Perform Otoscopic Examination
2. Align end of Probe Tube with
the
left end of the appropriate
guide
3. Align tube marker with the red
marker above
4. Place Probe Tube in ear canal
5. Confirm placement with
Otoscope
6. Perform Live Speech Mapping
& REM
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Rainbow Passage

When the sunlight strikes raindrops in the air,
they act like a prism and form a rainbow. The
rainbow is a division of white light into many
beautiful colors. These take the shape of a long
round arch, with its path high above and its two
ends apparently beyond the horizon. There is,
according to legend, a boiling pot of gold at one
end. People look, but no one ever finds it. When
a man looks for something beyond his reach, his
friends say he is looking for the pot of gold at the

end of the rainbow.

D-0117971-C 05/2019
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Real Ear Measurements

In addition to Live Speech Mapping, the Avant ARC supports all conventional Real Ear
Measurements (REM). All of these tests are accessed from the main Avant ARC-REM screen.

To begin, click E; S button on the right of the Avant main screen.
the reM b

In general, REM tasks are performed as follows:

EAvant REM - Avant ARC

Fle Function Ear Audio Target Stmulus Options... Took Help

Audo | FitingRx| REUR REUG  REIG REAR | REAG | | REOR | REOG 0  RECD Q I:m [mre= ]

) 8 | §
SPL (d8) -

Seup DSL
2+
24 y.0., Adult
- Insest/Mold
: : M T % 1m % % & & 8 ) | | RS SO [ A S SR S TE, Binaural, WDR
- 128 20 500 750 1k 1% 2k % 4k Bk 8k - 125 20 500 750 1k 1% 2% % 4k Bk &k | . g,,-‘,"""““
Frequency (Hz ) Ty (] || =
545
—— REAR: PRN, TD48 @
— f Conduction, M=41%, PTA=d5
— UL .
- Bx 7
— x
—— Fiting ix (DSL@8%B) p ke Lo
e— A Coduction. Me22Y. PTA=S0 ¥

| Coprrioha (C)2000-200% Pl nc

. Select the REM test you wish to perform from the top row of buttons.
. Select the test ear.

. Select the test stimulus.

. Click Start. The test will stop itself after sufficient data has been collected.

. If you wish to delete a curve, simply select it with your mouse (left click) and then click the
Discard icon or press the Delete key.

. When all measurements are complete, click the Back arrow to return to the AVANT Main
Screen.

u b~ WN =

(o))

Descriptions of the various “Stimulus” options are presented in the Help files under the topic
“Signal Types”. Access these by clicking on the “Help” tab at the top of the screen, and selecting
“Help Topics”. Select an item from the list in the Index tab, and click “Display”.

44
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Stimulus Signal Types

Pure Tone
A pure sine wave. Crest Factor = 1.41 (3.0dB)

Broadband Noise (BBN)
Uniform random noise with normal (Gaussian) amplitude distribution. Can be weighted to White, Pink, Speech ANSI, and Speech
Byrne (see below.)

Pseudo Random Noise (PRN)
A "synthetic" broadband random noise. It is less uniform than BBN, has lower spectral density and random volleys. Can be weigted to
White, Pink, Speech ANSI, and Speech Byrne (see below.)

ICRA Noise
This stimulus was developed for measuring characteristics of non-linear instruments. The noise is weighted to Byrne LTASS.

ISTS

(International Speech Test Signal)

Initiated by European Hearing Instrument Manufacturing Association (EHIMA.) This signal is based on natural recordings of 21 female
speakers in six different languages - American English, Arabic, Chinese, French, German and Spanish. The signal is largely non-
intelligible because of segmentation and remixing. The speech material was filtered to Byrne LTASS.

Crest Factor: 9.23 (19.3dB)

Rainbow Passage
Natural recordings of several voices reciting the rainbow passage. Shaped to Byrne LTASS.

Broadband Noise Weighting

White

This is essentially no weighting or filtering. The White Noise has flat power spectral density. Power at every frequency is equal.
Because the density of frequencies (individual cycles) raises with frequency, there is more energy in high octaves.
White-weighted noise can be used mostly for testing of equipment. It is not recommended to use it for hearing aid fitting, unless
specified by the manufacturer.

Crest Factor: BBN = 1.73 (4.8dB), PRN = 7.86 (17.9dB)

Pink

The noise is filtered so its energy per frequency (power spectral density) is inversely proportional to the frequency. Each octave carries
the same amount of energy. Comparing to White Noise, the Pink Noise energy drops approximately 3dB per octave.

Pink-weighted noise can be used mostly for testing of equipment. It is not recommended to use it for hearing aid fitting, unless specified
by the manufacturer.

Crest Factor: BBN = 3.67 (11.3dB), PRN = 6.55 (16.3dB)

Speech - Byrne

The noise is approximately weighted to International Long Terms Average Speech Spectrum (ILTASS) as described in Byrne et. al.,
1994,

The noise with this weighting is preferred for hearing aid fitting because its spectrum is the best approximation of the spectrum of real
human speech.

Crest Factor: BBN = 4.22 (12.5dB), PRN = 3.47 (10.8dB)

Speech - ANSI

The noise is approximately weighted to ANSI S3.42 Speech Noise.

The noise with this weighting can be used for fitting hearing aids. The slope of ANSI-weighted noise is not as steep as Byrne-weighted,
so there is more power in higher octaves. This will result in less gain required by the hearing aid to reach targets, but may result in
under-fitting at high frequencies.

Crest Factor: BBN = 4.46 (13.0dB), PRN = 5.17 (14.3dB)
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To activate specific REM tests, click the buttons as follows:

Opens the audiometry data entry screen. Use this if audiometry has not been previously
Audio measured and entered into NOAH.

. Allows the selection of fitting rules to generate targets. The following rules are supported:
FitingFix| | 1/ Gain, POGO |, POGO Il, Berger, 1/3 Gain, NAL-RP, FIG6, DSL, NAL-NL1.

Real Ear Unaided Response - Measures the additive effect of the ear canal’s resonance
REUR to a stimulus. Reported as dB SPL of output.

Real Ear Unaided Gain - Measures the additive effect of the ear canal’s resonance to a
REUG stimulus. Reported as dB SPL of gain. If a real ear unaided response (REUR) curve has
been measured, the corresponding real ear unaided gain curve is automatically plotted to
the REUG screen.

The difference between the REUG and the REAG is called the Real Ear Insertion Gain
REIG (REIG). This Insertion Gain information is used to compare to the target gain curve
selected for the client.

The Real Ear Aided Response (REAR) is the sound pressure level in the ear canal
measured with the probe microphone close to the eardrum and the operating hearing
REAR instrument inserted in the ear and turned on. ANSI defines REAR as the SPL, as a
function of frequency, at a specified measurement point in the ear canal for a specified
sound field, with the hearing aid in place and turned on.

The REAG is simply the REAR expressed as gain rather than SPL. Selecting REAG
REAG allows you to see the gain at each frequency for each of the REAR curves measured.

REOR measures the effect on the natural external ear effects resulting from inserting an
REDR ear mold or a hearing instrument, before it is turned on, into the ear canal. The REOR is
also referred to as Insertion Loss. REOR is also useful for validating the effectiveness of
venting or canal length changes to the mold.

The Real Ear Occluded Gain (REOG) is the difference in decibels, as a function of
frequency, between SPL in the ear canal and SPL at the reference microphone at the
REODG entrance of the ear canal with the hearing aid in the ear and turned off. For each REOR
measurement curve, the corresponding REOG curve is calculated and automatically
plotted to the REOG screen. The REOG function is useful in determining the acoustic seal
of a hearing aid, relative to a sound field outside the ear.

Some clients report they seem like they are “speaking in a barrel” or “feel blocked up”.
0/ These are signs of a build up of self generated low frequency energy in the ear canal. This
excessive occlusion can be measured objectively in the Occlusion Effect task.

The Real Ear to Coupler Difference (RECD) is used to simulate real ear measurements by
RECD coupler measurements and is useful when fitting children or “difficult” to fit patients. See
the section on RECD later in this manual for more detail.
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Additional Tests & Features
Real Ear to Coupler Difference (RECD)

The Real Ear to Coupler Difference (RECD) is used to simulate real ear measurements by coupler
measurements and is useful when fitting children or difficult to fit patients. RECD measurements
can be conducted outside of a Hearing Instrument Test Box when using the optional MedRx
RECD Coupler.

660-902 - RECD Coupler Assembly (REM use)

430-032

20C BTE 430-033

430-0;
2CC Body Adapter Adapter 2CCITE
NS1141

. Adapter
with O-Ring ?
) ]
o @ &2
o
Plastic Tubing
NS1143

Wit Plastic Ear Tips 4SO st e masmee mestanay

430-015 Green Probe Tube Pack

The RECD values are used as a correction to coupler measures for that client’s hearing
instruments. By performing all subsequent measures in the coupler and applying the RECD
corrections to the coupler measures, the “real ear” factors are incorporated into the results. The
resulting simulated measurements provide information to select and make adjustments to the
hearing instrument and verify adjustments in the MedRx coupler rather than in the
uncooperative client’s ear. This is particularly important in the case of children, whose small
volume ear canals enhance high frequency amplification more so than in average adults. This is
an essential consideration in determining the maximum output of the hearing instrument.

If RECD data is present, the software will display an option to choose between Ear or Coupler
measurement on all Real Ear screens where measurements in a coupler are appropriate.

There are two ways to measure the REAR response with optional RECD coupler: using an insert
headphone or a hearing instrument.

If a hearing instrument is used, its volume control setting and other parameters should remain
the same for both REAR and coupler measurements. Set the volume control to moderate, and
turn the compression and noise reduction circuits off.

Using open-fit hearing aids for RECD measurements may result in invalid low and mid-frequency

measurements because of insufficient gain at those frequencies. Please contact your hearing aid
manufacturer for recommendations.
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How to perform the RECD task

First, perform the REAR task to obtain an REAR curve. This can be measured with a hearing
instrument or an insert earphone.

REAR with a hearing instrument

\ \ e Adjust volume of the hearing instrument to comfortable
listening level. Turn the compression and noise reduction
circuits off.

e Position the client less than one meter from the speaker and
facing the speaker.

e Place the hearing instrument and the probe microphone tube
as for all REM measurements.

o Select START to open the measurement type selection screen.

e Choose the REAR with a Hearing Aid option.
e Select OK to begin the test and wait until it concludes.

REAR with an insert headphone

e Place the probe microphone tube as for all REM
measurements but use the insert headphone instead of a
hearing instrument.

e Select START to open the measurement type selection screen.

e Choose the REAR with an Insert Headphone option.

o Select OK to begin the test and wait until it concludes.
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Coupler Response

When the REAR is complete, you are prompted to perform a coupler response.

Attach the hearing instrument or the insert headphone (must
be the same as used in the REAR test) to the appropriate
coupler and place the probe tube inside the coupler.

If a hearing instrument is used, be sure to perform this
measurement at the same volume control setting as the first
measurement.

Select START to open the measurement type selection
screen.

Choose the Coupler Response option or Use Stored to
skip the measurement (see note below.)

Select OK and wait until the test completes.
The calculated RECD curve is automatically displayed on the

screen and is stored in memory for correction of subsequent
coupler measurements made from the RECD function.

& Note: If the REAR and the coupler response were measured with the insert headphone,
the program saves the coupler response curve for later use. In this case to obtain another
RECD, only REAR with insert headphone measurement is necessary. This is possible because
the coupler response does not change provided that neither the coupler nor the insert

earphone has changed.

& Note: After measuring RECD, it is possible to perform Live Speech Mapping in the
coupler as well. Look for the “Measuring in” option on the LSM screen.

D-0117971-C 05/2019
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Measuring Acoustic Feedback

Feedback (whistling, howling) is one of the most common complaints of hearing instrument
users. Even though many modern hearing instruments have sophisticated feedback
management systems, knowing exactly where the feedback is occurring can greatly reduce the
time required to resolve the problem. The AVANT ARC system does an excellent job measuring
and displaying acoustic feedback.
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Frequency (Hz)

1.

Place the calibrated probe tube in the ear canal as
instructed previously.

Place the hearing instrument in the ear without
disturbing the probe tube.

Begin a Live Speech Mapping session as
instructed previously.

When feedback is present, click the Start button.
Acoustic feedback appears as a large spike in the
LSM response.

If a more specific frequency analysis of the
feedback is desired, change the resolution of the
system to 1/24 octave by clicking the Options
menu item and changing the Analyzer selection
using the pull-down menu. This image shows the
same feedback as above at 1/24 octave.

Using this information, make any necessary

adjustments to the hearing instrument to reduce
or remove the feedback.
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Printing

Printing within the Avant ARC software is very simple.

m Function Ear Output Audio Stimulu

Open
Save

Clear Session Data

Page Setup...

Print Setup... K

Print Preview

Print,..

Go Back Ctrl-Back

Exit Alt-F4

From the File menu, click one of the following options:

Page Setup - Allows you to set margin sizes and the
default text header for your reports.

Print Setup - selects the printer you want the report to
be sent to.

Print Preview — Shows you what your report will look
like before you print it.

Print — Sends the report to the printer. This option
opens the Windows Print dialog which allows the user
to select any installed printer and modify the
properties (quality, number of copies, etc.) for the print
job.

Device Maintenance

Annual re-calibration of the transducers used with the Avant ARC is recommended. There are no
user repairable components of this device.

Refer to the Installation Manual for care and cleaning instructions.

Customer supplied components of this Medical Electrical system should be cleaned and
maintained according to their manufacturer’s instructions. (laptops, amplifiers, etc.)
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Symbols that may be used:

Read the instruction
manuals for safe usage of
the device
(operating instructions)

()

Non-ionizing
electromagnetic radiation

Read the instruction
manuals for safe usage of
the device
(operating instructions)

v

Calibration

@

CAUTION
For Single Patient Use
Only

SN

or SN

Indicates that the device
serial number will follow

2

Special Disposal Required

[

Class Il equipment

Loudspeaker (Speaker)

R

Type B applied part. (Type B
equipment)

90%

et
30%

Humidity Limitation

D

Start (of action)

()

L/

Headphones

sl

Manufacturer
(MedRx)

AN

Caution, General
warning sign

Y,

Stop (of action)

O

Microphone

|EC| REP |

Authorized
Representative in
Europe

35C

10C

Temperature
limitation

>

Percentile Setup

Recording

&I The date of manufacture is shown on the original calibration certificate. The year of manufacture is

shown in the fourth character in the serial number. M=2014, N=2015, P=2016, Q=2017 etc.
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Limited Warranty

MedRx, Inc warrants this product to be free from defects in material and
workmanship for one year from the time of purchase. If this system fails to
perform as specified during this period, the purchaser is responsible for
calling MedRx at (888) 392-1234 or (727) 584-9600. The company's represen-
tative will advise the owner to either return specific components or the entire
system to:

MedRY, Inc.
1200 Starkey Road #105
Largo, FL 33771 USA

MedRx will repair or replace any defective devices, fully test the system
and/or components and ship the system promptly back to the owner. There is
no cost for the repair or return shipping, provided the system is one year old
or less and has not been misused, abused or damaged. Such damage
includes, but is not limited to, dropping, exposure to excessive heat greater
than 100°F and water/liquid damage.

Repair or replacement of the system as provided under this warranty is the
sole and exclusive remedy of the purchaser. MedRx shall not be liable for any
consequential or incidental damages or for breach of any express or implied
warranty. Except to the extent of applicable law, any implied warranty,
merchantability or fitness of this product is limited to the duration of this
warranty.

MedRx will, at its discretion, service and repair out of warranty products at the
purchaser's request, charging for parts and labor as necessary.

The limited warranty is deemed void if software or hardware is installed on
this product which is not pre-approved by MedRx, Inc. Approved software
includes NOAH™ and HIMSA approved hearing aid manufacturer
programming modaules for fitting hearing aids.

MedRyx, Inc is not responsible for problems resulting from installation of
unapproved software or hardware. In the event of unapproved software or
hardware installed on the system causing a conflict, MedRx will service the
product for a fee to be determined at the time of service.

Any extension of this warranty past the initial one-year warranty is subject to the
following (where applicable).

1. A $300 deductible per repair.

2. Extended warranty does not include cables, connectors or peripherals.

3. Extended warranty of the Video Otoscope covers optics only.
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